Sequence Clip Reporter

Sequence Clip Reporter creates an Excel spreadsheet report about the video clips, audio clips
and markers you've used in your edited sequence. The report includes sheets for:

° C|I|:_)S,
e Sequence Markers,

e Clip Markers
e Text Generators

e Transitions

e Clip Filters

e Motion Tab settings and
° Re_els

You can choose which tracks of clips to include in the report, and Preferences lets you choose
whether durations are reported as seconds (for easier spreadsheet calculations), frames or
HH:MM:SS:FF timecode format.

Please use Provide Feedback... under the application menu for bug reports, feature requests
or support.

Loading your project into Sequence Clip Reporter

From Final Cut Pro 7 automatically

1. Open your project if it isn’t already open in Final Cut Pro.
2. Run Sequence Clip Reporter. The last opened project will be imported automatically.

3. To switch to another project, open it in Final Cut Pro and switch back to Sequence
Clip Reporter. The new project will be imported for you.

From Final Cut Pro 5/6/7 or Premiere Pro CS5 using XML export

1. Open your project if it isn’t already Export XML...
open in your editing application.

2. Choose the File menu and select Source: Bins: 17, Clips: 319, Sequences: 1

Export > X_ML"' (Final Cut Pro) or Format: _ Apple XML Interchange Format, version 4 B
Export > Final Cut Pro XML...
(Premiere Pro). Options

3. In Sequence Clip Reporter, click | Include Master Clips Outside Selection

the Open XML file... button or
choose the File menu and select
Open... to open the exported XML; ( cancel ) [ oK )
or drag-and-drop the XML file to
the dock tile.

(¥ Save project with latest clip metadata (recommended)

4. To switch to another project, open it in your editing application and export a new
XML file for opening into Sequence Clip Reporter.



Analyzing your Sequences

1.

In Sequence Clip Reporter choose the sequence you want to analyze from the
Sequence popup menu, then click the Analyze button; or, if your project has only
one sequence, it is automatically analyzed for you.

Tip: If you need to report video only or audio only, you can set a preference to
analyze only the track types you want (see Preferences). Analyzing only video or
only audio is faster than analyzing both.

report.

. To leave out audio in

clips that also contain
video, click the

Ignore audio in clips
with video checkbox

on.

. To add optional

sheets to the report
for markers, text
generators,
transitions, filters,
motion tab settings or
reels, click the
appropriate
checkboxes 'on'.

. If you want the

spreadsheet to open
after the file is saved,
click the Open the
spreadsheet after
saving checkbox 'on'.

. Click the Save

spreadsheet...
button. Name and
save the spreadsheet.

The spreadsheet can then be
rearranged and customized, or
the content of the spreadsheet
copied and pasted into a pre-
made template.

You can create reports for
another sequence in your
project by selecting it from the
Sequence popup menu and
clicking the Analyze button.

. Click the checkboxes 'on' for each video and audio track you want to include in the

e O 0 Sequence Clip Reporter
Open XML file ’))‘
i
Swing Dancing Today!
Sequence: | The Lindy Hop = Analyze

Choose the sequence tracks to include in the report:

Video Tracks Audio Tracks

™ Track V1 ™ Track A1
M Track V2 (¥ Track A2
|21 Track A3
(¥ Track A4

All None All None

Enabled clips and tracks only
Ignore audio in clips with video

Choose the optional sheets to add to the report:

™ Add report sheets for Markers
121 Add a report sheet for Text Generators
“ Add a report sheet for Transitions
V Add a report sheet for Filters
@Add a report sheet for Motion tab settings
“ Add report sheets for each Reel

QI Open the spreadsheet after saving

Save spreadsheet... (2)




Clips Report

Lists the video and/or audio clips for the chosen tracks in order of their appearance
(regardless of which track the clip is in). The report includes columns for: Track; Clip Name,
Enabled; Sequence In timecode; Sequence Out timecode; Clip Duration (calculated from
Sequence In/Out timecode); Source Reel Name; Source In timecode; Source Out timecode,;
Source Duration (calculated from Source In/Out timecode); Sound Roll Name; Source File

Path; logging information (Description, Scene, Shot Take, Log Note, Scene Note, Shot

Note, and Take Note); and comments (Master Comment 1, Master Comment 2, Master
Comment 3, Master Comment 4, Comment A, and Comment B).
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00:05:06;26
02:12:04;21
02:41:43;06
02:12:21;02
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< | A B c | D E F
1 Track Clip Name Enabled SequenceIn Sequence Out Clip Duration
2 |A3 Jumptown s 00:59:56;12 01:00:32;24 00:00:36;13
3 |A1 Rob Dialog s 01:00:04;12 01:00:29;12 00:00:25;01
4 (Vi Rob Dialog v 01:00:04;12 01:00:06;04  00:00:01;23
5 V1 Blcomies / 01:00:06;,05 01:00:10;07 00:00:04,03
6 V1 Johnny n Cari / 01:00:10;08 01:00:12;24 00:00:02;17
7 V1 Round n Round / 01:00:12;25 01:00:18;11 00:00:05;17
8 |v1 Jeremy Solo s 01:00:17;22 01:00:20;24 00:00:03;03
9 |vi Reb Dialog v 01:00:20;25 01:00:24;11 00:00:03;17
10 V1 Overhead v 01:00:24;12 01:00:32;24 00:00:08;13
Sequence Markers Report
Lists the sequence markers in order of their appearance. The report includes columns for:
Marker Name; Type (Note, Chapter, Compression or Scoring); Comment; Start timecode;
End timecode; Duration; and Color.
< A B C D
1 Marker Name Type Comment Start
2 |Marker 1 Note 00:00:12;21
3 |Marker 2 Note There's a lot of stops.. 00:00:20;02
4 |Marker 3 Note 00:00:29;11
Clip Markers Report
Lists the clip markers in order of their appearance (regardless of which track the clip is in).
The report includes columns for: Track; Marker Name; Clip Name; Comment; Start
timecode; Duration; and Color.
< A B C
1 Track Marker Name Clip Name
2 V2 Marker 1 0020Len_Lye__ Swinging_the_ Lambeth_Walk
3 |v2 Marker 1 0020Len_Lye Swinging_the_Lambeth_Walk
4 V1 Marker 1 200904 16-180855-03
5 |Vi Marker 2 200904 16-180855-03

Sourc
00:00
00:00
00:00
00:00
00:00
00:00
00:00
00:00
00:00

D E F G
Comment Start Duration Color

00:20:10:00 Red

00:20:10:18 Red

00:20:48:08 Red

00:20:52:04 Red



Text Generators Report

Lists the generators in the chosen video tracks. The report includes columns for: Track; Clip
Name; Text Generator; Sequence In timecode; Sequence Out timecode; Duration; Font; and
the Text content entered for the title.

<
1
2
3

A B = D E F G H
Track Clip Name Generator Sequence In Sequence Out Duration Font Text
V2 Text Text 01:00:04;12 01:00:06;04 00:00:01;23 Geneva Roeob Dance Instructor
V2 Text Text 01:00:10;08 01:00:12;01 00:00:01;23 Geneva Johnny and Cari

Transitions Report

Lists a summary of the Apple and Third-party transitions used and the transitions in the
chosen tracks. The report includes columns for: Track; Transition name; Sequence In
timecode; Sequence Out timecode; and Duration. Third-party transitions are highlighted
with red text.

A B s D E
Apple Transitions
Slide » Spin Slide
Wipe » Center Wipe

Third-Party Transitions

SpotLight
Track Transition Sequence In Sequence Out Duration
V1 Wipe » Center Wipe 01:00:17;22 01:00:18;11 00:00:00;20
SpotLight 01:00:24;12 01:00:25;11 00:00:01;00

= oW Nown awN =G

V1
V1 Slide » Spin Slide 01:00:30;25 01:00:32;24 00:00:02;00

Clip Filters Report

Lists a summary of the Apple and Third-party filters used and the filters applied to video
and/or audio clips for the chosen tracks. The report includes columns for: Track; Filter
name; Enabled; Clip Name; Sequence In timecode; Sequence Out timecode; and Duration.
Third-party filters are highlighted with red text.

< A B s D E F G

1 Apple Filters

2 Gain

3 Soft Focus

4 Tint

5

6 Third-Party Filters

7 Advanced Blur

8

9 Track Filter Enabled Clip Name Sequence In Sequence Out Duration
10 A3 Gain v Jumptown 00:59:56;12 01:00:32;24 00:00:36;13
11 A4 Gain v Jumptown 00:59:56;12 01:00:32;24 00:00:36;13
12 |V1 Soft Focus v Blcomies 01:00:06;05 01:00:10;07 00:00:04;03
13 |Vv1 Advanced Blur v Round n Round 01:00:12;25 01:00:18;11 00:00:05;17
14 V1 Soft Focus Round n Round 01:00:12;25 01:00:18;11 00:00:05;17
15 V1 Tint Jeremy Solo 01:00:17;22 01:00:20;24 00:00:03;03




onwcnmawm.—-o

Motion Tab Settings Report

Lists the Motion tab settings applied to video clips for the chosen tracks. The report includes
columns for: Track; Motion setting name; Clip Name; Sequence In timecode; Sequence Out
timecode; and Duration.

< A | B C D E F

1 |Motion Applied

2 Crop

3 Distort

4 Motion Blur

5 Time Remap

6

7 Track Motion Clip Name Sequence In Sequence Out Duration

8 |V1 Motion Blur Round n Round 01:00:12;25 01:00:18;08 00:00:05;14

9 |vi Time Remap Round n Round 01:00:12;25 01:00:18,08 00:00:05;14

10 |V1 Crop Jeremy Solo 01:00:17;20 01:00:20;22 00:00:03;02

11 'V1 Distort Jeremy Solo 01:00:17;20 01:00:20;22 00:00:03;02

12 ‘V1 Motion Blur Overhead 01:00:24;10 01:00:32;20 00:00:08;10
Vi

Time Remap Overhead 01:00:24;10 01:00:32;20 00:00:08;10

Reels Summary Report

Lists all the reels used in the sequence, the - -

. ) . < A B C
estimated total duration of material used 1 Source Reel Name Estimated Total % of Total
from each reel, and the percentage of total 2 001 00:00:31:11 57%
material used from each reel. The report 3 002 00:00:23.23 439
includes columns for Source Reel Name,;
Estimated Total; and % of Total.

Reels Reports

A report sheet is created for each source reel for clips in the chosen tracks. Each sheet lists
the video and/or audio clips for the chosen tracks in order of their appearance (regardless of
which track the clip is in). The report includes columns for: Track; Clip Name; Enabled;
Sequence In timecode; Sequence Out timecode; Clip Duration (calculated from Sequence In/
Out timecode); Source Reel Name; Source In timecode; Source Out timecode; Source
Duration (calculated from Source In/Out timecode); Sound Roll Name; Source File Path;
logging information (Description, Scene, Shot Take, Log Note, Scene Note, Shot Note, and
Take Note); and comments (Master Comment 1, Master Comment 2, Master Comment 3,
Master Comment 4, Comment A, and Comment B). An Estimated Total for Source Duration
is included at the bottom of the Source Duration column.

B C D E F G H I J
Clip Name Enabled SequenceIn Sequence Out Clip Duration Source Reel Name Sourcein Source Out Source Duration
Bloomies % 01:00:06;,05 01:00:10;07 00:00:04,03 002 02:12:04;21 02:12:08;23 00:00:04,03
Johnny n Cari s 01:00:10;08 01:00:12;24 00:00:02;17 002 02:41:43,06 02:41:45;22 00:00:02;17
Round n Round % 01:00:12;25 01:00:18;11 00:00:05;17 002 02:12:21;02 02:12:26;18 00:00:05;17
Jeremy Solo s 01:00:17;22 01:00:20;24 00:00:03;03 002 02:42:36,09 02:42:39;11 00:00:03;03
Overhead % 01:00:24;12 01:00:32;24 00:00:08;13 002 02:39:29,03 02:39:37;15 00:00:08;13

Estimated Tolal: 00:00:23,23



Sort Ascending
Sort Descending

Filtering reports in Excel ~ (Show All)
(Show Top 10...)
Excel has powerful features for filtering a spreadsheet. (Custom Filter...)

1. In Excel, choose the Data menu, and from the Filter
sub-menu select AutoFilter. A popup menu indicator Algonquin Hotel N

is added to the headings of the frontmost sheet. Cabaret Convention

2. To show only those rows where, say, Master Comment Capital Records

1 is “Algonquin Hotel”, click the Master Comment 1 Central Park

popup menu indicator and select Algonquin Hotel David Campbell's Apartment
from the menu. The spreadsheet changes to show only David Jones Store

those rows with Algonquin Hotel in the Master Don't Cry Mama

Comment 1 column. Jindabyne Family Home

3. For more powerful filtering, choose Custom Filter... Media One
from the popup menu. The Custom AutoFilter dialog SOM Theater
opens. (See Excel’s help topic “Filter a list of data” for

; ) Stars at State
more information.)

(Show Blanks)
Preferences (Show NonBlanks)

Choose the Sequence Clip Reporter menu and select
Preferences to open the Preferences window.

Importing

You can choose whether to import both video and audio tracks, only video tracks, or only
audio tracks. Importing just video or audio tracks is faster than importing all tracks.

Durations

You can choose whether durations are reported as seconds, frames or HH:MM:SS:FF
timecode format. Drop frame or non-drop frame timecode will be used depending on
the sequence setting.

Row Colors

You can choose to have the spreadsheet rows for video clips, audio clips and markers set to
different colors. Excel has 15 different colors available.

Thumbnails

You can choose to create thumbnail images of the video In point at sizes from 40 pixels wide
to 640 pixels wide. Thumbnails are saved as JPEGs in the same folder as the Excel
spreadsheet and are named using the row number and clip name. If the media is offline, the
thumbnail will be a “Media Offline” graphic instead of the In point.

Updates

Use the Check at Launch checkbox to choose whether to automatically check for software
updates. You can manually check for software updates by clicking the Check now button, or
by choosing the Sequence Clip Reporter menu and selecting Check for Updates... Checking
for software updates occurs only when you are connected to the internet.

The latest version of Sequence Clip Reporter can also be downloaded from any internet-

connected computer by visiting www.AssistedEditing.com/downloads.


http://www.AssistedEditing.com/downloads/
http://www.AssistedEditing.com/downloads/

After you install Sequence Clip Reporter onto a computer, it will need to be activated with a
Serial Number before it can be used. Each serial number can be used to activate only one
computer at a time. If you want to activate the software on another computer, you’ll need to
deactivate it first. See Moving Sequence Clip Reporter to another computer for details.

You’ll temporarily need internet access for the activation so that the software can connect to
our server and confirm the serial number.

e When the software is first run it will display a Software License Agreement. Read the
license agreement and click the | Agree button at the bottom of the page.

e Enter the Serial Number that was given to you and click the Activate button. The
software will send the serial number to our server for confirmation.

e You’ll get a message in green saying that you’ve successfully activated your license.
Click the Continue button.

If the software could not be activated with the Serial Number, you’ll get a message in red
explaining the reason, such as:

e This is not a valid Serial Number - check to make sure you have entered the serial
number correctly;

e This is not a Serial Number for Sequence Clip Reporter - make sure you’re entering a
serial number that can be used to activate Sequence Clip Reporter;

e The Serial Number has already been activated - if you want to activate Sequence Clip
Reporter on this computer you'll need to deactivate the other installation before
activating this one, or purchase another serial number.

To move Sequence Clip Reporter from one computer to another, you'll deactivate it on the
first computer, then activate the installation on the second computer.

To deactivate the software on one computer and activate it on a different computer, both
computers will temporarily need internet access.

e On the first computer, choose Deactivate from the application menu.
o Confirm that you want to deactivate the software by clicking the Deactivate button.

e You’'ll receive a message in green saying that you’ve successfully deactivated your
license.

¢ On the second computer, run Sequence Clip Reporter, and follow the instructions for
Activating Sequence Clip Reporter.



